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Overview of Corticon Installations
This guide presents the preparation and procedures for accessing, downloading, and running Corticon 5.6
installers, as well as dynamic access to the supported platforms and links to the setup of third-party software
in the Progress Corticon KnowledgeBase.
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Preparing for a Corticon Installation
Before running installers
To avoid possible constraints on the installer, do the following:

• Confirm that you have Administrator permissions on the target machine - Administrator rights allow
the installer to copy all the Corticon files to their proper locations. You must have Administrator rights and
permissions to install this software. See your system administrator to obtain these rights.

• Obtain system access - Several Corticon features write files to the “home” directory structure. If the target
machine for the Corticon installation does not have read and write access to this directory, you need to
choose a directory location where Corticon will have both read and write access.

• Disable anti-virus, anti-malware, and anti-spyware protection applications - Before performing the
installation, we recommend temporarily disabling any anti-virus and anti-spyware software that may be
running on the target machine, as such software might interfere with correct installation.
For details, see the following topics:

•

Evaluation licensing

•

System requirements

•

About Corticon upgrades

•

Downloading Corticon installer packages

•

Applying a Service Pack update
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Evaluation licensing
Progress Corticon products are licensed for evaluation immediately after installation.
Studio Licensing - Corticon embeds a ninety-day evaluation license that enables development of business
rules projects and the use of the Enterprise Data Connector (EDC), as well as testing of the projects in an
embedded test server. You must obtain Studio development licenses from your Progress representative.
Server Licensing - Corticon embeds a limited evaluation license that enables testing of rule modeling projects
on supported platform configurations. You must obtain server deployment licenses and server licenses that
enable the Enterprise Data Connector (EDC) from your Progress representative. See Limits of the Server
evaluation license on page 40 to determine whether the evaluation license will constrain your evaluation.

System requirements
Progress Corticon products are supported on a variety of platforms and third-party components.

Corticon Studio
Refer to the Progress Software web page Progress Corticon 5.6 - Supported Platforms Matrix to review the
currently supported Corticon Studio operating systems, and Eclipse versions.
The target system for a Corticon Studio installation requires:

• Supported Windows operating system
• 8 GB System RAM (minimum of 2 GB available RAM)
• 650 MB disk space
• When an existing Eclipse will be used, a supported Eclipse version
Corticon Server for Java
Refer to the Progress Software web page Progress Corticon 5.6 - Supported Platforms Matrix to review the
currently supported platforms and application servers. Also see the Corticon KnowledgeBase entry Corticon
Server 5.X sample EAR/WAR installation for different Application Servers for detailed instructions on configuring
Apache Tomcat, JBoss, WebSphere, WebLogic on all supported platforms.
The target system for a Corticon Server for Java installation requires:

• Supported Windows or Linux operating system
• When deploying on other platforms, a supported operating system and application server
• 8 GB System RAM (minimum of 2 GB available RAM)
• 600 MB disk space
Corticon Server for .NET
Refer to the Progress Software web page Progress Corticon 5.6 - Supported Platforms Matrix for information
on supported .NET Framework and IIS versions, and the Corticon Knowledgebase article appropriate for your
target IIS/platform, as listed in the topic Setting up and updating IIS for .NET Server on page 33.
The target system for a Corticon Server for .NET installation requires:
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• Supported Windows operating system
• Supported .NET Framework and Internet Information Service (IIS)
• 8 GB System RAM (minimum of 2 GB available RAM)
• 500 MB disk space
Note: Corticon's Enterprise Data Connector (EDC) can be configured for Corticon Studio and either Corticon
Server. Refer to the Progress Software web page Progress Corticon 5.6 - Supported Platforms Matrix to review
the currently supported databases when using EDC with Corticon Studio or Server.

Corticon Web Console
Refer to the Progress Software web page Progress Corticon 5.6 - Supported Platforms Matrix for information
on supported browser versions.
The target system for a Corticon Web Console installation requires:

• Supported Windows or Linux operating system
• 4 GB System RAM (minimum of 2 GB available RAM)
• Java option for MaxPermSize set to at least 256m
• 600 MB disk space
Note: When all three Server components are installed on one machine, the required space for the installation
is about 1 GB.

About Corticon upgrades
Upgrading from an earlier release
Existing Corticon users advancing to this release will want to know whether their existing products can co-exist
with the newer version, as well as any strategies for perpetuating the assets created in their current version.
Note: Starting with this release, Service Packs and patches will roll up into the latest installer. That means
that a downloaded 5.6 installer will install fresh components at the current release level or update existing 5.6
installations with the latest updates.
If you have an existing installation of Corticon products on the target machine, do the following:

• For an upgrade of a 5.3.x, 5.4.x, or 5.5.x installation to 5.6.x - If you are upgrading from 5.3, 5.4, or 5.5
installed software on the same machine, 5.6.x will install to new location and run independent of the other
releases. You must manage any port overloads that might result from running both versions.

• For an upgrade of a 5.2 or earlier version 5 installation to 5.6.x - An installed version of Corticon 5.2 or
earlier installed on the target machine must be uninstalled, then the appropriate Corticon 5.6 product installed.
You might want to consult with Progress Corticon Support or your Progress representative to discuss your
migration strategies for existing assets before you take action.

• For an upgrade of a 4.3 or earlier installation to 5.6.x - An installed version of Corticon 4.3 or earlier
installed on the target machine must take an intermediate step of upgrading its assets to at least 5.3, and
then uninstalled. To accomplish this, you must download and install Corticon Studio 5.3.0 or 5.4.0, and then
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perform the procedures in its Corticon Migration Guide. Once completed, uninstall the 4.3 installation, and
install 5.6.x where its upgrade utility can bring project assets up to date. You might want to consult with
Progress Corticon Support or your Progress representative to discuss your migration strategies for existing
assets before you take action.

Downloading Corticon installer packages
To download required Corticon installers:
1. Get credentials to access and download packages on the Progress Software Electronic Software Download
(ESD) site.
2. Connect to the ESD, and then navigate to the Corticon 5.6.1 page.
3. Locate, download, and save the required installers to a temporary location accessible by the target machine.

Downloading the Corticon Studio installer package
For supported 64-bit Windows machines: PROGRESS_CORTICON_5.6.1_STUDIO_WIN_64.exe

Downloading the Corticon Server and Web Console packages
Microsoft Windows
Corticon Server and Web Console 5.6 products for Windows -- Java Server, .NET Server, and Web Console
-- are packaged in executable installer applications and ZIP archives:

• For supported 64-bit Windows machines: PROGRESS_CORTICON_5.6.1_SERVER_WIN_64.exe
• For installing Corticon Server or Web Console on other supported platforms or application servers:
PROGRESS_CORTICON_5.6.1_SERVER.zip.
Note: The deprecated Java Server Console is packaged as
PROGRESS_CORTICON_5.6.1_SERVER_CONSOLE.zip within the PROGRESS_CORTICON_5.6.1_SERVER.zip
file available on ESD. It includes user documentation and instructions on installing it in a 5.6 Java Server
installation.
Linux
Corticon Server and Web Console 5.6 products for Linux -- Java Server, and Web Console – are packaged in
executable installer applications for supported 64-bit Linux machines:
PROGRESS_CORTICON_5.6.1_SERVER_LNX_64.bin

Applying a Service Pack update
When Progress releases a Service Pack for a version, the update is applied to an existing installation that the
Service Pack update wizard discovers on the target machine. To apply a Service Pack, navigate to the download
page to get the appropriate package, and then unpack it on the target machine. The installer will provide a new
installation with the 5.6 installation as well as its current service packs. An existing installation will upgrade in
place with the updated service packs.
Note: A higher Service Pack for a version rolls up the features of all preceding Service Packs.
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Installing Corticon Studio
There are several techniques for installing Corticon Studio:

• Running the Corticon Studio installer wizard on page 14, the typical use, which enables a complete Corticon
Studio Eclipse installation that can standalone, or be tailored into another Eclipse IDE on the same machine,
such as Progress Developer Studio for OpenEdge.

• Performing Silent Installations of Studio on page 19 that generates a file from an installer wizard run to let
you perform silent Studio installations on other machines.

• Installing Corticon Studio plugins into an existing Eclipse on page 19 which enables scripted installation of
Corticon Studio plugins into an existing Eclipse.

What Corticon Studio installers provide
The installer wizard package includes:

• Corticon Studio resources
• Corticon Studio online documentation
• Eclipse Development Environment and Eclipse online documentation.
• Java Runtime Environment (JRE)
• Sample projects
• Tutorials
• API documentation for extending Corticon
• Corticon Server runtime for use in testing rules you create in Corticon Studio
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Installation options
A new Corticon Studio install lets you choose to install it standalone, or to add its resources to either Progress
Developer Studio for Open Edge 11.4/11.5 or another existing Eclipse 4.3 installation.
For details, see the following topics:

•

Running the Corticon Studio installer wizard

•

Performing Silent Installations of Studio

•

Installing Corticon Studio plugins into an existing Eclipse

•

Tasks after Studio is installed

Running the Corticon Studio installer wizard
The Studio installer will install or update Studio 5.6.x.

Installing or updating Studio 5.6.x
To perform a new installation of Corticon Studio 5.6.x:
1. Double click on the installer file, PROGRESS_CORTICON_5.6.1_STUDIO_WIN_64.exe, to launch the
Corticon Studio installer.
The installer opens in the installer wizard.
2. The first installer panel opens with information about the installer.

3. Click Next to continue.
The License Agreement panel opens.
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This panel displays the Progress Software End User License Agreement (EULA). Use the scroll bar at the
right of the screen to read the agreement content.
4. When you understand and agree to the terms, choose I accept the terms in the license agreement, and
then click Next to continue.
The Choose Install Folder panel opens.
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5. Specify the installation location. The default location for the installation directory and the work directory are
as shown above. (For the work directory, the default subdirectory under Users is the current username.)
Either accept the default locations, or specify each preferred (and different) location.
6. If you see the upgrade panel instead, Corticon Studio is already installed. You cannot change its install
location or bind it to a different Eclipse such as PDS OE without doing a complete uninstall and re-install.

7. Click Next.
8. The installer attempts to discover an existing Progress Developer Studio for OpenEdge on the machine. If
the Eclipse/OpenEdge version are compatible, and if the installer is the corresponding bit width, the following
panel opens:
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If this panel is displayed, choose whether to add the Corticon Studio plug-ins into that Progress Developer
Studio for OpenEdge location to get the benefit of a tailored installation, and then click Next to continue.
9. If you had no Progress Developer Studio for OpenEdge installation, or passed on installing into a discovered
Progress Developer Studio for OpenEdge, the External eclipse configuration panel opens:

• If you select Yes on this panel, the entry area for the External Eclipse location in which you want to
add Corticon Studio (in addition to a standard installation) is presented:
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Enter or browse to the location of the Eclipse target that is the same bit width as the installer you are
running.

• If you leave the selection as No, a normal installation will proceed.
When you have decided which path to take, click Next to continue.
10. The Pre-installation Summary panel opens.
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Confirm that your installation location has adequate disk space for the Corticon Studio components as well
as at least 100 MB of workspace.
11. Click Install to continue.
An installation status window opens to display the state of the installation process. When the process has
finished, the Install Complete panel opens.
12. Click Done to quit and close the installer.
The installation or update of Corticon Studio 5.6.x is complete.

Performing Silent Installations of Studio
An unattended (silent) install requires that you first run an installation or updater in the installer wizard to capture
the selected options, and then use the captured response file on other targets to 'playback' the responses into
the installer without any user interaction.
Note: The bit width of the installer package and the target machine's bit width must correspond.
To perform silent installations for Corticon Studio:
1. Run the Studio installer with your preferred locations and options to capture a response file, using the syntax
installer.exe -r file where installer is the preferred Studio installer, and file is the response
file you will reuse. For example, PROGRESS_CORTICON_5.6.x_STUDIO_WIN_64.exe -r
C:\CorticonStudio64_56x.responses
2. On other target machines, access the Studio 5.6.x installer executable and the response file.
3. On those machinres, run the installer using the syntax installer.exe -i silent -f file where
installer is the Studio installer, and file is your response file. For example,
PROGRESS_CORTICON_5.6.x_STUDIO_WIN_64.exe -i silent -f
C:\CorticonStudio64_56x.responses.

Installing Corticon Studio plugins into an existing
Eclipse
These instructions apply when you want to install Corticon functionality into an installed Eclipse IDE. The
technique uses a script to install plugins into an installed Eclipse 4.3.1 or 4.3.2 development environment.
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1. A Java Software Development Kit (JDK) is required for Corticon, not just a Java Runtime Environment
(JRE). If you do not have one installed locally, download and install a 1.6 or higher (1.7 preferred) version
of the same bit-width as the existing Eclipse from the Oracle Java website
http://www.oracle.com/technetwork/java

Note: For the installation of the Corticon Studio plugins, you can use the JRE that Eclipse is using. In
Eclipse, choose Window > Preferences, then select Java > Installed JREs.
2. Download and perform a standard installation of Corticon Studio into a clean directory on the target machine.
This installation will provide the script and the required files for the integration into your target Eclipse
location.
3. In a Command Prompt window at the Corticon Studio's [CORTICON_HOME]/Studio location, check to
see whether JAVA_HOME is set. If not, set JAVA_HOME to the JDK root. For example: set
JAVA_HOME=c:\jdk1.7u67_64
4. Confirm that neither the installed Corticon Studio or the target Eclipse are running.
5. In the Command Prompt, run the integration script in the form:
integrateCorticon.bat –install

eclipse_target

where eclipse_target is the root directory of the target Eclipse installation.
Eclipse installs its required plug-ins.
6. To ensure that Corticon Ruletests can locate javac to compile rules, add the path of the JDK to your PATH
as the default Java to use. For example:
set PATH=%JAVA_HOME%\bin;%PATH%

7. Specify the Corticon work directory, the folder where you want Corticon to write its log and other temporary
files. For example:
set CORTICON_WORK_DIR=c:\corticon_work_dir

8. When the script successfully completes, restart the Eclipse session, and then verify the installation by
selecting the menu command Help > About Eclipse. Click Installation Details to confirm that Progress
Corticon Feature is installed.
9. Open a project, and then run a Ruletest. A successful run indicates that the Java compiler is being accessed
correctly.
The integrateCorticon script enables other functions:
COMMAND SYNTAX AND OTHER OPTIONS
================================
Usage: integrateCorticon [OPTION] [TARGET_ECLIPSE]
Manage installation of Corticon plugins in an Eclipse install
-install
Install Corticon plugins in TARGET_ECLIPSE
-uninstall
Uninstall Corticon plugins from TARGET_ECLIPSE
-update
Update Corticon plugins in TARGET_ECLIPSE
-updateParams Update Corticon plugins parameters in TARGET_ECLIPSE
-help
Display this message
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Tasks after Studio is installed
Once Studio is successfully installed, there are a few tasks you might want to perform.

Upgrade projects coming forward from a prior release
Every time you install a new release of Corticon Studio, many Corticon development assets (Vocabularies,
Rulesheets, Ruleflows, and Ruletests) might need to be upgraded for use in the Corticon Studio. These could
be projects you were working on or samples you imported from another location. As you open each asset that
needs to be upgraded, you are alerted as to the required action, and encouraged to proceed to upgrade it. The
asset upgrade process will force the upgrade of dependent assets that also require a similar upgrade. This
task can be tedious if you have a lot of assets and a lot of projects.
The project upgrade utility lets you choose projects or folders of projects that will be upgraded all in one pass.
Typically, you would bring the projects into your workspace but you could choose to point to folders that contain
projects.
Performing this procedure just after upgrading your Corticon Studio will relieve you of having to do this task as
you work.
To upgrade a selected project:
1. After your Studio upgrade has succeeded, choose the Upgrade Rule Assets command,
, on the dropdown menu that opens when you right-click on any project name in
the Projects Explorer view. The Upgrade Corticon Assets dialog box opens, as shown:

In this example, the LifeInsurance project was selected so all the assets in that project are selected for
upgrade.
2. Click Finish to start upgrade processing. You are alerted that this process cannot be undone, so consider
whether you should cancel, backup the files as-is, and then run the same upgrade process again to
completion.
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3. After processing, the Update Results window opens, listing the assets that required upgrade and were
upgraded, as well as those that did not require an upgrade, as shown:

You can choose to click Copy, and then paste the text into your preferred text editor.
4. Click OK to close the results window and the dialog box.
To upgrade one or more projects in one run:
1. Choose the Upgrade command,
, on the dropdown menu that opens when you
click Project on the Corticon menubar (or on the dropdown menu of a selected project in the Project
Explorer tabs) The Upgrade Corticon Assets dialog box opens.
2. Click Browse to navigate to the branch of tree that could contain several Rule Projects, and click OK. The
projects and their assets are listed in the Upgrade Corticon Assets dialog box, as in this example:

22

Progress Corticon: Installation Guide: Version 5.6.1

Tasks after Studio is installed

Note: For best performance, choose just several projects to upgrade in one run, and then perform as many
runs as needed.
3. Click Finish to start upgrade processing. You are alerted that this process cannot be undone, so consider
whether you should cancel, backup the files as-is, and then run the same upgrade process again to
completion.
4. After processing, the Update Results window opens, listing the assets that required upgrade and were
upgraded, as well as those that did not require an upgrade. You can choose to click Copy and then paste
the text into your preferred text editor.
5. Click OK to close the results window and the dialog box.

Ensure that all projects build as Corticon projects
Corticon Studio now uses the Eclipse builder mechanism to validate Corticon assets. An Eclipse builder thread
runs in the background to validate changed assets and their dependencies.
Corticon Studio performs the validation in the background when any asset is saved to see if other assets are
still valid. This validation does not block any interaction with Corticon Studio.
About validation...
The project validation process has an impact on available memory, and uses background CPU cycles. Here
are some tips:

• If your workspace has several large projects, try to keep inactive ones closed to optimize resources. This
is particularly important when you restart Studio, as it validates all open projects on startup. Closing projects
in your workspace that you are not working on limits the amount of validation done on startup.

• When performing tasks such as re-arranging assets in a large project, you might want to shut off the option
to Build Automatically. Once you have completed your changes, choose Clean, and then turn Build
Automatically on again.
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• When building large projects, follow the build progress in the Progress view (exposed from the menu item
Window > Show View > Other then General: Progress.

Corticon Nature
Corticon builds and extensions rely on your project having a Corticon Nature. The following illustration contrasts
a Corticon project and a generic project:

To convert a generic project to give it a Corticon Nature, right-click on the project's folder, and then select Add
Corticon Nature, as illustrated:

Evaluate the Studio's memory allocation
When working on large projects, you will get better performance by increasing the available memory for Corticon
Studio. To change the Corticon Studio memory allocation, edit the command file eclipse.ini located at
[CORTICON_HOME]\Studio\eclipse, and then change (typically, increase) the Xmx value (maximum
memory setting). The default Xmx setting is 2 gigabytes, specified as Xmx2g.

Participate in the Studio Customer Experience Improvement
Program
Corticon uses Progress Telerik Analytics to gather data that will help Progress Software determine product
usage trends and improve product quality.
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When you first launch Corticon Studio and specify a workspace, the Customer Experience Improvement
Program dialog box opens. Read through the information in the dialog, and then either check the option to
sign up for the Customer Experience Improvement Program, or clear the option to opt out. Clicking OK records
your decision.
If you click Cancel (or click the close box), you are opted out.
If you choose to change workspace, you must select whether that workspace will participate.
Once Studio is running under the selected option, you can review or change the setting from the Studio menu
Window > Preferences > Progress Corticon. The option and its current value are shown. If you change the
option, click Apply, and then click OK.
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Installing Corticon Servers and Web Console
This section provides information about the installation procedures for the deployment and administration
components of Corticon Server as well as the Progress Application Server (PAS) -- a Web application server
based on Apache Tomcat -- that is used by the Java Server and the Web Console.
Note: Linux Installation - When you download and run the Linux server installer, you get shell (.sh) scripts
for start/stop and utility tools that correspond to the batch (.bat) scripts in a Windows installation.
There are several techniques for installing Corticon Server components:

• Running the Server and Web Console installer wizard on page 28, the typical use, which enables a complete
Corticon Server for Java (and PAS), Corticon Server for .NET, and Corticon Web Console (and PAS).

• Performing silent installations of Server components on page 32 that generates a file from an installer wizard
run to let you perform silent installations of Server components on other Windows machines.

• Performing command-line Linux installations of Server components on page 33 enables the Linux installer
to run from the shell as a command with parameters.

• Using packages that facilitate setup of Corticon Server for Java and Corticon Web Console on supported
UNIX/Linux platforms and brands of Application Servers. Refer to the Progress Software web page Progress
Corticon 5.6 - Supported Platforms Matrix for the currently supported platforms and app servers. Then see
the Corticon KnowledgeBase entry Corticon Server 5.X sample EAR/WAR installation for different Application
Servers for detailed instructions on configuring Apache Tomcat, JBoss, WebSphere, WebLogic on all
supported platforms.
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Note: The previous console implementation, Server Console, that was enabled in a Windows Java Server
installation, is packaged as PROGRESS_CORTICON_5.6.1_SERVER_CONSOLE.zip within the
PROGRESS_CORTICON_5.6.1_SERVER.zip download file available on ESD. It includes user documentation
and instructions on installing it in a Windows 5.6 Java Server installation. This legacy tool will be phased out
in upcoming releases as the new Web Console replaces the legacy tool's functionality.

For details, see the following topics:

•

Running the Server and Web Console installer wizard

•

Performing silent installations of Server components

•

Performing command-line Linux installations of Server components

•

Setting up and updating IIS for .NET Server

•

Creating custom context URLs on a web server

•

Resetting the Web Console administrator password

Running the Server and Web Console installer wizard
The Server installer will install or update Servers and Web Console to 5.6.x.

Installing or updating Server and Web Console 5.6.x
You can install Corticon Servers and the Web Console on a machine that does not already have them installed.
If you are upgrading from 5.3, 5.4, or 5.5, you can install 5.6 as a separate installed software version on the
same machine. You must manage any port overloads that might result from running both versions.
Note: An installed version of Corticon Server 5.2 or earlier on the target machine must be uninstalled, then
Corticon Server 5.6 installed. Consult with Progress Corticon Support or your Progress representative to
consider your migration strategies for existing assets before you take action.

Installation procedure
If you have already installed either of the 5.6 Servers or the Web Console, the installer will allow you to install
components not previously installed, as well as update all installed components to the latest Service Pack.
To create or update an installation of Corticon Servers (Java and .NET) and Web Console 5.6.1:
1. On the target machine, access the Corticon 5.6.x installers you downloaded.
2. To open the Progress Corticon Server Setup Wizard:

• For Windows, double click on: PROGRESS_CORTICON_5.6.1_SERVER_WIN_64.exe
• For Linux, run: PROGRESS_CORTICON_5.6.1_SERVER_LNX_64.bin
The installer opens in the installer wizard. The first installer panel opens with information about the installer.
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3. Click Next to continue.
The License Agreement panel opens.

4. After you have read, understood, and agreed to the terms of the End User License Agreement, choose I
accept the terms of the license agreement, and then click Next.
The Choose Install Folder panel opens.
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5. The default installation directories are shown. To specify preferred directories on each line, either enter the
explicit path, or click Choose to browse to each preferred directory.
6. If you see the upgrade panel instead, Corticon Server components are already installed. You can add
previously unselected components but you cannot change the install location or uninstall existing components.

7. Click Next.
The Choose Server Components panel opens.
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8. Choose the one or more components you want to install at this time. Any components already installed are
chosen and greyed out.
Note: The Linux installer does not enable a Corticon Server for .NET installation.
Click Next.
If you selected the Java Server or Web Console, the Corticon Port Numbers panel opens.
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9. If any of the preferred ports conflict with existing applications, you can change them at this time to an integer
value from 1024 to 49151. Be aware that the documentation references these ports as though the default
values, as shown, were accepted. Consult with your system administrator to identify alternate ports you
might use, or to reset the ports on the conflicting applications.
Enter your preferred port numbers, and then click Next.
The Pre-Installation Summary page opens.
10. Verify your selections in the Pre-Installation Summary panel. Nothing has happened yet so you can click
Previous to go back to a panel to make changes, or click Cancel to quit this installation procedure.
11. Click Install to continue.
The installation status window opens.
When done, the Install Complete panel opens.

12. Choose Done to complete the Corticon Server / Web Console installation and close the installer.
The installation and update of Corticon Servers and Web Console 5.6.x is complete.
Note: Using an LDAP store for Web Console authentication - You can set up Corticon Web Console to
authenticate users using an LDAP server. See the topic "Additional tasks to set up LDAP for Web Console" in
the Integration and Deployment Guide.

Performing silent installations of Server components
An unattended (silent) install requires that you first run an installation in the installer wizard (Windows or Linux)
to capture the selected components and options, and then use the captured response file on targets on the
same platform to 'playback' the responses into the installer without any user interaction.
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Silent installations or updates for Corticon Server Components on Windows:
1. Run the Corticon Server for Windows installer with your preferred locations and options to capture a response
file, using the syntax installer.exe -r file where installer is the preferred Server installer, and
file is the response file you will reuse. For example, PROGRESS_CORTICON_5.6.x_SERVER_WIN_64.exe
-r C:\CorticonServer_56x_WIN.responses
2. On other target Windows machines, access the Server 5.6.x installer executable and the response file.
3. Run the installer using the syntax installer.exe -i silent -f file where installer is the
Server installer, and file is your response file. For example,
PROGRESS_CORTICON_5.6.x_SERVER_WIN_64.exe -i silent -f
C:\CorticonServer_56x_WIN.responses.

Silent installations or updates for Corticon Server Components on Linux:
1. Run the Corticon Server for Linux installer with your preferred locations and options to capture a response
file, using the syntax installer.bin -r file where installer is the preferred Server installer, and
file is the response file you will reuse. For example, PROGRESS_CORTICON_5.6.x_SERVER_LNX_64.bin
-r /usr/corticon/CorticonServer_56x_LNX.responses
2. On other target Linux machines, access the Server 5.6.x installer binary and the response file.
3. Run the installer using the syntax installer.bin -i silent -f file where installer is the
Server installer, and file is your response file. For example,
PROGRESS_CORTICON_5.6.x_SERVER_LNX_64.bin -i silent -f
/usr/corticon/CorticonServer_56x_LNX.responses.

Performing command-line Linux installations of Server
components
A command-line install runs a Linux installation in a command shell as a text command with parameters.
To perform command-line installations for Corticon Server components:
1. On a supported 64-bit Linux platform, access the downloaded Linux installer binary file,
PROGRESS_CORTICON_5.6.1_SERVER_LNX_64.bin
2. In a shell, run the binary with the console option. For example:
# ./PROGRESS_CORTICON_5.6.x_SERVER_LNX_64.bin -i console

A JRE is extracted and the installer is launched.
3. Follow the prompts to complete the installation via the command-line.

Setting up and updating IIS for .NET Server
The runtime server for Corticon Server for .NET is Microsoft Internet Information Services (IIS), a distinct setup
into which you install the latest Corticon resources. This topic links to initial setup of IIS, adjustments to its
setup when upgrading, and the follow-up task to every upgrade or service pack update that copies the latest
resources to the IIS location.
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To setup IIS to support Corticon Server for .NET 5.6.x, access the appropriate Corticon Knowledgebase article
that describes the complete configuration of .NET Framework and IIS:

• Steps to set up IIS 7.5 on Windows Server 2008 or Windows 7 for Corticon Server for .NET 5.x. These
instructions are also appropriate for Windows 10.

• Steps to set up IIS 8.0 and 8.5 on Windows Server 2012 R1 and R2 for Corticon Server for .NET 5.x These
instructions are also appropriate for Windows Server 2016.
Note:
To upgrade IIS for Corticon 5.6 - If you already have IIS setup for Corticon 5.4, you need to adjust its
configuration to support new features.
In Control Panel > Programs and Features, select Turn Windows feature on or off, and then expand to
Internet Information Services > World Wide Web Services. Select all the features in the group Common
HTTP Features.
To upgrade or update Corticon Server for .NET into the IIS location:
1. Start Administrative Tool > IIS Manager. In the Actions panel, click Stop.
2. In [CORTICON_HOME_5.6]\Server .NET\IIS, launch install.bat.
3. Accept or adjust the target location, and then press Enter. The 5.6 resources and the deployment descriptor
files are copied. The corresponding assets are copied to the IIS path, /Samples/Rules Projects.
4. In the IIS Manager, on the Actions panel, click Start.

Creating custom context URLs on a web server
Corticon web service deployment is preset to a singular web service identity, axis. To access that web service,
you might enter http://localhost:8850/axis. You can choose to run multiple instances of Corticon
Server on the same host:port , such as http://localhost:8850/another. This enables you to use
one application server, yet create unique Decision Service URL end points that provide isolation to different
sets of Decision Services.
To add another Java WAR file to a Java web server:
This example clones the default WAR file, axis.war that was deployed on the embedded Progress Application
Server, and then configures and runs the new web archive successfully.
1. Stop the Java web server.
2. In [CORTICON_WORK_DIR]\pas\server\webapps, copy axis.war, and then paste it there to make a
copy.
3. Edit the name axis - Copy.war to your preferred .war name. Use alphanumeric characters and
underscores, and no spaces. For example Java_UAT.war for your user acceptance testing instance. The
new WAR file will be expanded into its directory structure when you start the application server.
4. To configure settings specific to this new Corticon Server node, expand the WAR file with an archive utility,
such as WinZip.
5. Navigate in the new context's file location to
\Server\pas\server\webapps\Java_UAT\WEB-INF\lib\CcConfig.jar.
6. Extract and edit the CcServer.properties file as follows:
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• Change the line
com.corticon.ccserver.sandboxDir=%CORTICON_WORK_DIR%/%CORTICON_SETTING%/CcServerSandbox
to
com.corticon.ccserver.sandboxDir=%CORTICON_WORK_DIR%/%CORTICON_SETTING%/Java_UAT/CcServerSandbox

• Change the line com.corticon.ccserver.autoloaddir=%CORTICON_WORK_DIR%/cdd to
com.corticon.ccserver.autoloaddir=%CORTICON_WORK_DIR%/Java_UAT/cdd

• Change the line
com.corticon.server.embed.managementWebLogDirectory=%CORTICON_WORK_DIR%/logs
to
com.corticon.server.embed.managementWebLogDirectory=%CORTICON_WORK_DIR%/Java_UAT/logs

• Save the edited file.
7. Extract and edit the cccommon.properties file, and then change the line
logpath=%CORTICON_WORK_DIR%/logs to logpath=%CORTICON_WORK_DIR%/Java_UAT/logs
8. Save both files and replace them in the CcConfig.jar.
9. Repackage the entire set of files back into its WAR file.
10. Restart the Java web server.
The two Java server deployments run. Using the Web Console, you can manage the two distinct server context
URLs, for example, myServer:8850/axis and myServer:8850/Java_UAT.
To add another Corticon .NET web service to an IIS server:
This example clones the default .NET web service, axis that was installed from a Corticon Server for .NET
installation to an IIS server configured for Corticon web services, and then runs the new application successfully.
1. In the IIS Manager, on the Actions panel, click Stop.
2. In the Server .NET's [CORTICON_HOME]\IIS folder, copy install.bat, and then paste it there to make
a copy.
3. Edit the name install - Copy.bat to your preferred .war name. Use alphanumeric characters and
underscores, and no spaces. For example install_anotherNET.bat.
4. Edit that file to replace all instances of axis with anotherNET, and then save the edited file.
5. Run the script.
6. Navigate in the new context to C:\inetpub\wwwroot\anotherNET\conf.
7. Edit the CcServer.properties file as follows:

• Change the line
com.corticon.ccserver.sandboxDir=%CORTICON_WORK_DIR%/%CORTICON_SETTING%/CcServerSandbox
to
com.corticon.ccserver.sandboxDir=%CORTICON_WORK_DIR%/%CORTICON_SETTING%/AnotherNET/CcServerSandbox

• Change the line com.corticon.ccserver.autoloaddir=%CORTICON_WORK_DIR%/cdd to
com.corticon.ccserver.autoloaddir=%CORTICON_WORK_DIR%/AnotherNET/cdd

• Change the line
com.corticon.server.embed.managementWebLogDirectory=%CORTICON_WORK_DIR%/logs
to
com.corticon.server.embed.managementWebLogDirectory=%CORTICON_WORK_DIR%/AnotherNET/logs

• Save the edited file.
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8. Extract and edit the cccommon.properties file, and then change the line
logpath=%CORTICON_WORK_DIR%/logs to logpath=%CORTICON_WORK_DIR%/AnotherNET/logs
9. Save the edited file.
10. In the IIS Manager, perform the same tasks that were performed when axis was installed into IIS. In brief:
a. Set Access Permissions for the application's directories,
b. Convert the new folder into an application.
c. Set the application to use the appropriate application pool.
See Setting up and updating IIS for .NET Server on page 33 for more information and links to the various
IIS setup articles in the Knowledgebase.
11. In the IIS Manager, on the Actions panel, click Start.
The two .NET server deployments run. Using the Web Console, you can manage the two distinct server context
URLs, for example, myServer:80/axis and myServer:80/anotherNET.

Resetting the Web Console administrator password
If the login password of the Web Console administrative user (admin) is lost, Corticon provides a way to reset
the password to the default (also admin).
To reset the administrator's password:
1. Stop the Corticon Server that is running the Web Console.
2. Select Start > All Programs > Progress > Corticon 5.6 > Corticon Command Prompt.
3. Enter set JAVA_OPTS=-DCORTICON_RESET_ADMIN_PASSWORD=true.
4. Enter pas\server\bin\startup.bat.
Corticon Server starts and resets the administrator's password.
After completing these steps, you can connect the Web Console and log in with the default administrator
credentials, user admin, password admin. It is good idea to immediately replace the default password with
your preferred administrator password.
This procedure applies to the application server that is installed by Corticon Server--the Progress Application
Server. You can perform similar steps for other supported application servers and platforms. Consult your
application server documentation for how to pass the JVM system property
CORTICON_RESET_ADMIN_PASSWORD to the server.
Note: Do not set this property in startup scripts as it will reset the password on each startup. This should be
only done only when the password needs to be reset. Subsequent launches of Corticon Server and the Web
Console should use the normal startup procedures.
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5
Registering your Corticon license
Progress Corticon customers must replace the evaluation license to enable the licensed features and time
limits.
When you obtain a license file, it applies to Studios as well as Servers. You must perform configuration tasks
to record it for each Corticon Studio, each Corticon Server, and each Deployment Console. If you intend to
use EDC on your Corticon Servers, your Corticon license must allow it. Contact Progress Corticon technical
support if you need to acquire a license.
For details, see the following topics:

•

Updating your Corticon Studio license

•

Updating your Corticon Server license

Updating your Corticon Studio license
When you are provided a license for Corticon Studio, you receive a JAR file. Save the file on the target machine
or at a location that is network-accessible to the installation. The default license file for evaluation is embedded
within the installation and cannot be replaced directly. In this example, the license file, CcLicense.jar, that
both Studio and Server will use is placed at C:\licenses.
To update the evaluation Studio license, or add your non-evaluation Studio license:
1. With Studio running, select the menu command Window > Preferences.
2. Expand the Progress Corticon group.
3. In the License File entry area, enter or browse to the location of the license JAR:
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4. Click Apply, and then click OK.
5. Restart Corticon Studio.

Limits of your Corticon Studio license within Progress Developer
Studio for OpenEdge
To facilitate creation of a combined OpenEdge and Corticon Eclipse development environment, Corticon Studio
includes a WAR file to enable running Corticon Server from the Progress Developer Studio. The embedded
Studio license for Corticon Server has the following constraints:

• Corticon Server requests must originate on the machine where the server is running -- in other words, all
on localhost. Requests from any other machine or host are not allowed.

• Corticon Server allows only one reactor for execution of one instance of a specified Decision Service. As
a developer, you can locally deploy many Decision Services simultaneously, and you can use administrative
functions, such as service availabilities. When you are ready for production system testing, you must obtain
a Corticon Server deployment license, and then locate it in Corticon Server installations.

Updating your Corticon Server license
When you obtain a Server license file as a customer, you need to locate it at the default locations as well as
the runtime locations.
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Updating the .NET server license
Copy your CcLicense.jar file, and then paste it to replace the existing file at:

• [CORTICON_HOME]\Server .NET\samples\lib\
• [CORTICON_HOME]\Server .NET\webservice\lib\
• The IIS location, typically: C:\inetpub\wwwroot\axis\lib\
Updating the Java server license
Copy your CcLicense.jar file, and then paste it to replace the existing file at:

• [CORTICON_HOME]\Server\lib\
Note: When you download .ear and .war files for deployment onto other supported platforms and application
servers, they contain the evaluation CcLicense.jar. Once you are a Corticon customer, you are provided
a permanent version of this file. Inserting the CcLicense.jar file into the .ear or .war will replace the
evaluation file to redefine the license limitations.
Once you have run Corticon Server, you can update its license locations with your license.
To configure Corticon Server to access your license file:
1. Stop Corticon Server.
2. Copy your license JAR by its default name, CcLicense.jar.
3. Navigate to the installation's [CORTICON_HOME]\Server\lib directory to paste the file and overwrite
the existing file in that location.
4. Navigate to the installation's
[CORTICON_WORK_DIR]\Server\pas\server\webapps\axis\WEB-INF\lib directory to paste the
file and overwrite the existing file in that location.
When you restart Corticon Server, your license file will be referenced.
When you launch the Corticon Deployment Console, your license with its registration information is registered
for the Corticon Deployment Console. If your license enables EDC, the Database Access fields and functions
are enabled.
Note:
You can choose to locate the license by another JAR name at a preferred location, and then expressly identify
it to the server.
To custom configure Corticon Java Server's license location:
1. Navigate in the file system to the installation's [CORTICON_HOME]\Server\bin subdirectory.
2. Double-click on testServerAxis.bat, then do the following:
a. Type 416 and then press Enter.
b. Enter (or copy/paste) the complete path to the location of the license JAR file, as in this example,
C:\licenses\myCorticon_EDC_CcLicense.jar. The command echoes back Transaction
completed.
c. To confirm the setting, type 415, and then press Enter. The path is echoed back.
3. For the in-process instance, double-click on testServer.bat to perform the same 416 and 415 tasks
as in Step 2 above
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Limits of the Server evaluation license
The license included in the default Corticon Server installation has pre-set limits on certain Corticon Server
and Decision Service parameters. These limits are:

• Number of Decision Services – Up to 20 Decision Services may be deployed at any given time. This
means the sum total of all Decision Services loaded via .cdd files, Web Console, or APIs cannot exceed
20.

• Number of Rules – All rules in all deployed Ruleflows (that is, all deployed Decision Services) must not
exceed 500. A rule generally consists of a single Condition/Action Column or a single Action row in Column
0. Filter expressions do not count because they only modify other rules.

• Enterprise Data Connector (EDC) - EDC is disabled in a Server evaluation license and must be explicitly
licensed in a deployment Server license. Note that the Corticon Studio enables EDC in both evaluation and
deployment versions.
The Corticon Server log can capture errors and exceptions caused by expired or “under-strength” licenses. These
log messages are detailed in the Using Corticon Server logs section of the Integration and Deployment Guide.
If you are Progress Corticon customer, you should have access to an unlimited license that will lift these
restrictions. If you are an evaluator, and discover that these limitations are preventing or inhibiting your evaluation,
contact your Progress Software representative to get a license with expanded capabilities.
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Uninstalling Corticon Products
Uninstalling Corticon Studio
To remove a version of Corticon Studio, use this procedure.
Note: Uninstall removes a complete major.minor version. You cannot uninstall just a Service Pack.
Note: Uninstalling Corticon Studio 5.6.x will not impact any other installed major.minor version of Corticon
Studio.
To uninstall Corticon Studio:
1. Close Corticon Studio.
2. Choose the Start menu Control Panel function Programs and Features, and then double-click on Progress
Corticon Studio 5.6.x to launch its uninstaller.
Note: You could initiate the same task directly by navigating to [CORTICON_HOME]\Uninstall_Progress
Corticon Studio 5.6, and then running Uninstall Progress Corticon Studio 5.6.exe.

The installed files in the Studio's [CORTICON_HOME] are removed. Files you created (including the complete
workspace) are NOT removed or replaced during this process.
If the Uninstaller program is unable to fully remove components (usually because they are open), it will display
messages, and might require a reboot to complete the process.

Progress Corticon: Installation Guide: Version 5.6.1

41

Chapter 6: Uninstalling Corticon Products

Uninstalling Corticon Server
To remove a version of the server components to prepare for a new installation (or if you want to fully remove
them), use this procedure. The installed files in the Server's [CORTICON_HOME] are removed. Note that files
you created are NOT removed or replaced during this process. No server files in the [CORTICON_WORK_DIR]
are removed.
Note: Uninstall removes a complete major.minor version. You cannot uninstall just a Service Pack. If the
Uninstaller program is unable to fully remove components (usually because they are open), it will display
messages, and might require a reboot to complete the process.
Note: The Corticon Server components -- Corticon Server for Java, Corticon Server for .NET, and the Corticon
Web Console -- use common installation directories. As such, you cannot choose to uninstall just selected
components. Uninstallation will remove all installed server components.
To uninstall Corticon Server on Windows:
1. Stop Corticon Server.
2. Backup any files you want to retain.
3. Choose the Start menu Control Panel function Programs and Features, and then double-click on Progress
Corticon Server 5.6.x to launch its uninstaller.
Note: You could initiate the same task directly by navigating to [CORTICON_HOME]\Uninstall_Progress
Corticon Studio 5.6, and then running Uninstall Progress Corticon Server 5.6.exe.

To uninstall Corticon Server on Linux:
1. Stop Corticon Server.
2. Backup any files you want to retain.
3. In a command shell, navigate to [CORTICON_HOME]\Uninstall_Progress Corticon Studio 5.6,
and then run Uninstall Progress Corticon Server 5.6.bin.
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Access to Corticon knowledge resources
Complete online documentation for the current release
Corticon online tutorials available in the Corticon Learning Center:

• Tutorial: Basic Rule Modeling in Corticon Studio
• Tutorial: Advanced Rule Modeling in Corticon Studio
• Modeling Progress Corticon Rules to Access a Database using EDC
• Connecting a Progress Corticon Decision Service to a Database using EDC
• Deploying a Progress Corticon Decision Service as a Web Service for Java
• Deploying a Progress Corticon Decision Service in process for Java
• Using Corticon Business Rules in a Progress OpenEdge Application
Corticon guides (PDF):

• What's New in Corticon
• Corticon Installation Guide
• Corticon Studio: Rule Modeling Guide
• Corticon Studio: Quick Reference Guide
• Corticon Studio: Rule Language Guide
• Corticon Studio: Extensions Guide
• Corticon Server: Integration and Deployment Guide
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• Corticon Server: Web Console Guide
• Corticon Server: Deploying Web Services with Java
• Corticon Server: Deploying Web Services with .NET
Corticon JavaDoc API reference (HTML):

• Corticon Server API
• CorticonExtensions API
See also:

• Introducing the Progress® Application Server
• Corticon documentation for this release on the Progress download site: What's New Guide (PDF), Installation
Guide (PDF), PDF download package, and the online Eclipse help installed with Corticon Studio.
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